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Installing This Update
The latest version of EasyCatalog can be installed using the installer that can be downloaded from our web site:
http://www.65bit.com/downloads

These Release Notes detail the changes made to EasyCatalog since the previous version and may include details of 
new functionality that is not yet included in the main EasyCatalog User Guide.  
Maintenance releases of EasyCatalog will also include a number of bug fixes, so it is a good idea to check that you’re 
always running the latest version of EasyCatalog using the ‘Check for Updates’ button on the ‘About EasyCatalog’ 
dialog.

Enhancements

EasyCatalog 

Improved performance of loading data sources by storing formatted content. [1862]

In previous versions, EasyCatalog would rebuild all formatted content (i.e. apply cleansing, prefix, suffix, numeric formatting, etc) 
and also recalculate the value of Custom Fields each time InDesign boots.  This formatted content is now cached which greatly 
improves the launch time of EasyCatalog and InDesign. 

This caching can be turning off the “Cache Formatted Data” option on the Advanced preferences dialog. 

Added new “Versions” panel 

A new panel has been added to EasyCatalog to help make creating multi-version content easier. EasyCatalog is now able to 
automatically create multiple versions of the same document by looking for differences in the source data.  For example, if 
you’re producing a flier that needs to be different by country  or region, EasyCatalog is able to create these different versions 
automatically.  When using the versions panel, each box in the document can belong to multiple versions at the same time.

Further information on the Versions panel can be found here:  https://www.65bit.com/docs/using-versions-panel/

Added support for “Matrix Tables”

A new option has been added to the “Table” menu (from the data panel’s pop-out menu) to enable “Matrix” tables to be 
configured. A matrix table is a table that expands both horizontally and vertically.  Using the Matrix Table dialog, it is now possible 
to specify a field that will be used to determine the number of columns and rows: a new row will be created for each unique value 
in the ‘rows’ field; a new column will be created for a each unique value in the ‘columns’ field.  

Further information on this can be found here: https://www.65bit.com/docs/matrix-table-configuration-dialog/

New menu option “Import Data Source” is available on the File > New > EasyCatalog Panel menu. [1997]

This menu option can be used to import data source folders into the user’s workspace folder, and was primarily designed to 
import a data source folder that has previously been “Packaged” by EasyCatalog.  It is possible, however, to select any data 
source folder that has been copied from an EasyCatalog Workspace folder.

Upgrading from Previous Versions

About This Document

AS WITH ANY SOFTWARE UPGRADE, ALWAYS BACKUP YOUR EASYCATALOG 
WORKSPACE FOLDER AND DOCUMENTS PRIOR TO INSTALLING THE LATEST 
VERSION. !

http://www.65bit.com/downloads
https://www.65bit.com/docs/using-versions-panel/
https://www.65bit.com/docs/matrix-table-configuration-dialog/
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When importing a packaged data source, one panel will be opened for each of the configurations stored in the “Open Panels” 
folder. If there are no configurations or the “Open Panels” folder does not exist, a default panel for the data source will be opened 
instead.

The pagination library, if present, will be copied into the data source’s “Assets” folder and the Paginate dialog will be re-pathed to 
this new location.

Enhancements to the “Field Options” dialog and functionality

•  Added ‘Percentage’ field type to output decimal values as a percentage - e.g. 0.7 as 70%. [1553]

•  Appearance field options now apply to column headers in the panel. [1798]

•  Added new “Custom” picture location for script-based image importing. [1959]

For images that are sourced externally but are not URL or File based, the “Custom” option can be chosen in the picture location 
section of the field options.

When this is set, EasyCatalog looks for a file called ‘CustomImageImport.jsx’ in the ‘Scripts’ folder of a data source. 

Further information on this can be found here: https://www.65bit.com/docs/custom-image-import/

•  Month and weekday names are now localised when formatting dates. By default they will use the language specified by the 
InDesign user interface, but this can be changed by prefixing the format with the language required:  [1979]

[fr_FR]%d %B %Y

•  A new option has been added to the “Advanced” pane: “Show as ‘in error’ when overset”.  This option is on by default; when it’s 
switched off fields that are overset will no longer cause the field to be shown in red in the EasyCatalog panel.  [2008]

•  Added ‘notes’ field to Field Options dialog - this can be used to store notes/memos for each field, for example to detail its purpose.
 [2026]

•  Tooltips now show content of the ‘Notes’ field when hovering over the column header in the data panel. [2029]

•  Added ‘Rotation’ to Picture Content pane in field options - specify a field that contains the rotation to apply to an image within the 
frame. [2054]

•  Added separate horizontal and vertical scale options on Picture Content pane in field options, which allow the user to specify 
different fields for applying horizontal and vertical scale to the picture. [2055]

•  Scale options on Picture Content pane now support negative values [2056]

•  Field names in popups on Picture Content pane are now sorted alphabetically [2057]

•  The “Location” field on the “Picture Content” pane can now resolve to full path to a file - e.g. Macintosh 
HD:Users:jdoe:FIELDSTR(image).jpg [2120]

•  “Import...” button on Field Options > General panel will now import UTF-8 and Unicode files [2106]

•  Added Japanese Yen to the currency list [2237]

• Added a new Advanced field option to exclude a field from being updated during a Synchronise With Data Source action [2200]

Added “Advanced” preferences dialog

•  Added ability to configure “Advanced” preferences from the EasyCatalog Preference panel [2117]

• Advanced preferences are now available to:

• Specify the default workspace folder location (used when the user rebuilds InDesign’s preferences)

https://www.65bit.com/docs/custom-image-import/
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• Specify the default setting for the “Multiple Users Share This Workspace” option.

• Lock the workspace preferences to prevent the user changing the workspace folder or ““Multiple Users Share This Workspace” 
option.

• Change the label that’s displayed in the bottom right hand corner of picture boxes.

• Automatically purge deleted records after ‘Synchronize with Data Source’

• Modify the timeouts used when retrieving data or an image from a URL.

• Output the field marker characters to either PDF or print.

• Show groups in the panel as ‘in error’ if the group contains a mix of placed and unplaced records.

• Enable sockets for LUA, which allows remote debugging during execution of LUA code.

• Specify default parameters for each of the data providers.

Further information can be found here: https://www.65bit.com/docs/advanced-preferences/

Book Panel menu enhancements

• Document report and ‘Report’ from book panel menu now show the content status shown in the panel for each field (e.g. green 
or red). [2035]

•  Update Panel > With Page Positions added to the book panel menu [2052]

•  Added ‘Update Panel > All’ to the Book panel menu [2070]

•  Added “Remove Field Markers” to book panel menu [2214]

Snippets can now be imported into image boxes

•  Support has been added to import snippets into image boxes.  Configuration of this is through the picture content pane of Field 
Options: if the path to the ‘image’ resolves to a ‘.idms’ file, EasyCatalog will import the snippet into the picture box. 

If the snippet needs to be updated it will be re-imported (i.e. changes to the snippet’s position and scale within the containing box 
will be lost). [2052]

•  Snippets containing EasyCatalog fields/Field Specifiers will be populated with data for the record(s) being paginated during import.
 [2097]

Improved Reference Documentation

Reference documentation is now generated automatically and installed with EasyCatalog.

•  Reference documentation for the Scripting Module (if installed) is available from the “Help” menu.

• LUA documentation is now available by pressing the (i) button, which is available on any dialog where LUA code is entered.

‘Custom’ Field Adoption

A new ‘Custom’ option has been added to the “Adopt Fields” menu option which allows more complex field re-linking to be 
performed.  Users can now write LUA code that will be processed for each of the existing links in the document, setting the new 
data source, field name and key field that the field should be linked to. 

Further information can be found here: https://www.65bit.com/docs/custom-adoption/

https://www.65bit.com/docs/advanced-preferences/
https://www.65bit.com/docs/custom-adoption/
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‘Custom’ Reports

The custom report option allows provides a mechanism to inspect data source or document related information and output it in 
virtually any format.  The report itself is produced via LUA code that the user provides.  

Further information can be found here: https://www.65bit.com/docs/custom-reports/

Auto pick-up modifications

•  Added support for ‘/m’ at end of regular expression auto pickup to enable multi-line support. When this flag is set the regular 
expression will be evaluated for each paragraph in the text, rather than the entire text content of the story. [2004]

REGEX:(?<Field 1>[/\*0-9A-Z\-]{3,}).*?(?<Field 2>[0-9]+\.[0-9]{2})\s*(^p|^n|^t)/m

•  Using a regular expression with auto pickup now includes the end of paragraph marker. This should make picking up the last 
instance of the expression easier as it will always end in a new paragraph character. [2005]

Record Viewer modifications

•  Added new ‘spread’ button to the Record Viewer/ EasyCatalog Lite panel. When this is pressed the data source pop-up will 
automatically update when switching between spreads to show the data source of fields used on the current spread. [2126]

•  “Selection” option on Record Viewer panel now changes data source popup to the data source of the field(s) in the document 
selection. If fields from multiple data sources are selected only the first data source will be selected. [2047]

• Added “Copy” right click menu option to the Record View Panel to copy the select fields text [1523]

•  Added the ability to drag and drop Field Specifiers and field content into a text insertion point on the Record Viewer Panel [2211]

• Searching text on the Record Viewer Panel now gives results in data source order [2216]

Keyboard shortcuts/Right-click menu modifications

•  Added new right-click option “Show Columns Containing Errors” which will show all columns that contain errors, hide all columns 
that don’t [2098]

•  ‘Paste’ right click menu option now supports pasting table cell content that has been copied to the clipboard [2107]

•  “Insert Selection” now available as keyboard shortcut in EasyCatalog Lite [2122]

•  “Markup Field” keyboard shortcut will now remove any zero width characters from marked-up content [2129]

•  Added “Duplicate Custom Field...” right-click menu option. New field is created with “ copy” appended to existing name, and this 
can be changed in the dialog that appears. [2027]

Fields sorted alphabetically

•  Fields are now sorted alphabetically on the following dialogs:

• Replace Fields dialog [1987]

•  Subset dialog [2220]

•  Update Panel > With Page Numbers’ [2221]

Localization

•  Some German UI strings have been updated to reduce ambiguity [1987]

•  Added Spanish translations to Auto Pickup dialog [2146]

https://www.65bit.com/docs/custom-reports/
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General Usability Improvements

• A new checkbox has been added to the group dialog to exclude groups that have no name and no records under them (only 
groups). [1460]

•  Add option to prevent images being downloaded from a URL.  There is a new option on the “Images” sub-menu called “Prevent 
Images from being Downloaded” [1592]

• With logging enabled, any duplicate records removed during synchronisation will be logged  [1690]

•  Added “Remove Field Markers” to EasyCatalog Lite panel [1967]

•  Double click now inserts a tabular field [1990]

• Double clicking a placed tabular field now selects it in a document [2198]

•  Folders inside of workspace folder can now be aliases/shortcuts to folders - e.g. replace the “Images” folder with an alias to 
another folder to share images between data sources. [2086]

• Remove Field Markers > All will also remove hidden table attribute characters [2195]

• It’s now possible to drag a selection from the main data panel body by clicking and holding an existing selection. In previous 
versions, records needed to be dragged to the document from the small (status) column at the left of the panel. [2188]

• ‘Replace Fields’ dialog now also shows fields that are in the document but not in the data source. [1801]

• Field Specifiers can be dragged from a regular panel by holding shift key down and dragging the header [2212]

• Holding the shift key down while pressing the ‘Activate’ button will now present a new manual activation wizard [1953]

• Ability to copy and paste cell content in an EasyCatalog Panel. [2082]

• Hold down Shift + Ctrl (Windows) or Shift + Cmd (Mac) when selecting “Update Data Source” to output an Excel file containing 
the data source’s data rather than a CSV file. [2242]

Formatted Text

•  Style names found by name irrespective of the style group they belong to [1759]

•  Improvements to whitespace handling in HTML fields.  [1994]

• ‘Allow All Whitespace’ will now output whitespace outside of tag content [1975]

•  Different style sheets can now be specified that will be used depending on how deeply the tag is nested.  For example:

<ul>
 <li>List item 1</li>
 <ul>
  <li>List item 2</li>
 </ul>
</ul>

 The user can now specify a stylesheet called ‘ul>ul’ to apply a different stylesheet to the second unordered list. [1993]

• With enhanced HTML parser, EasyCatalog will now also attempt to match Formatting Rules to tag names.  If found, the Formatting 
Rule will be inserted into the text. e.g.

<FR1/>My text
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If there is a Formatting Rule called ‘FR1’, it will be inserted before the ‘My text’ text. [2215]

• <br> tag now inserts a soft return rather than a hard return [1989]

Performance

•  Performance enhancement when populating tables with column resizing attribute set. Text was being measured unnecessarily in 
each column when it wasn’t needed. [2088]

•  Performance enhancement when deleting all of the text in a text frame/table cell [2222]

Misc.

•  Cell Finder now has a new option to update cells at the bottom of a column [2051]

• Document Report’ now includes panel content in the ‘Notes’ field of the report [2094]

• Tabular Field Configuration dialog, lists can either be shift or command selected. [2226]

• When changing the parameters for a data source, hold down the ALT key during synchronization to perform an incremental 
synchronize. This will allow you to see the records that were inserted, deleted and updating during the synchronize. The default 
behavior (without the ALT key held) will be to retrieve a fresh snapshot of data (not showing the records that were inserted, deleted 
or updated). [2017]

Custom Fields 

• Custom fields can now be renamed [1520]

Custom fields can now be renamed using the Field Options dialog.  Note that any fields in the document that are linked to this field 
will not be relinked; other custom fields that refer to the renamed field will not be adjusted to reference the renamed field. 

•  FOLDERSEARCH now optionally returns all matches if the last parameter is TRUE [2015]

• Added additional parameter to URLSTR to specify username and password for HTTP authentication: [2018]

URLSTR(‘http://www.apple.com’,’jdoe:password’)
 

• Added XREFFIELDLIST custom field function, which combines the functionality of XREFFIELD and GROUPLIST. This function will 
find multiple instances of the ‘search for’ field and return them as a separated list. An external data source can be searched by 
specifying the data source name in the last paramter. [2121]

Description Required

String Field to search 

String Field content to search for 

String Field contents to return 

String First separator

String Middle separator

String End separator

String Data source to search

•  Added “CREATERANGES” custom field command, which can be used to create a range of non-numeric values such as clothing 
sizes. This function takes the following parameters: [2131]
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Description Required

String The separator used in the ‘values’ string (parameter 5) 

String Valid values (sorted in the correct order) 

String Separator to use between singular values in the output 

String Separator to use between value ranges in the output 

String The values string to parse and sort 

CREATERANGES(‘,’,’S,M,L,XL,XXL,XXXL’,’,’,’-’,’S,M,L,XXL,XXXL’)

will output

S-L,XXL,XXXL

•  Added support for regular expression in field name parameter for GROUPGETNTHPOPULATEDFIELDNAME - e.g. The following 
command will examine all fields whose name begins with ‘t_’ and return the third (index 2 = the third field) populated one.

GROUPGETNTHPOPULATEDFIELDNAME(group,2,’^^t_.*’)

[2133]

•  Added GROUPGETNTHPOPULATEDFIELD to get the nth populated field, which takes three parameters:

Description Required

String Group Path 

String The index of the field name to retrieve 

String A regular expression defining the names of the fields to search 

e.g. The following command will examine all fields whose name begins with ‘t_’ and return the fifth (index 4 = the fifth field) 
populated one. 

GROUPGETNTHPOPULATEDFIELD(group,4,’^^t_.*’)

Note that this function will return the content of the fifth populated field, whereas GROUPGETNTHPOPULATEDFIELDNAME will 
return the name of the populated field.

 [2134]

• MIN/MAX commands now ignore blank parameters, rather than treating them as zero [2144]

• Function added to determine a field placed status:

GETFIELDPLACESTATE

Description Required

Field The name of the field to return the place status for 

Returns: ‘unplaced’, ‘ok’, ‘error’

• Function added to determine return the number of times a field has been placed in the front-most document:

GETFIELDPLACECOUNT
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Description Required

Field The name of the field to return the place count for 

Returns: a numeric value, the number of times the field has been placed in the front-most document.

• Regular EasyCatalog commands are executed when present in tabular field cells [2155]

•  FOLDERSEARCH and FOLDERDEEPSEARCH match on the filename using the regular expression [2166]

• Added GROUPGRIDLAYOUTORDER. This takes a page grid size, and fields for each records size, then assigns a sort order to 
each record, enabling them to be paginated using guide based pagination. [1615]

Enterprise Data Provider 

Sales Layer

•  Improved the handling of Sales Layer image fields [1999]

Salsify

•  Added support for inheriting attribtes from parent_id objects [2152]

•  Performance enhancement when importing data from Salsify [2161]

•  Digital Assets now imported from parent objects [2162]

Excel Data Provider 

•  CC2018/CC2019 - Updated Excel Data Provider to libxl 3.8.2 [2041]

LUA Commands 

• The following objects are new in this version of EasyCatalog:

Object Description

LINK Object representing an EasyCatalog link in the document

PROGRESSBAR Utility object to display and update a progress bar

FORMATTINGRULE Functions for manipulating boxes of a Formatting Rule. This object will be used in the “Post Processing” 
pane on the “Formatting Rules” dialog.

• The following methods are new in this version of EasyCatalog:

Object Method

topoints

showsaveasdialog

DATASOURCE getlocation

TEXT
insertfield

pagename

SELECTION get
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Object Method

FRAME releaseanchored

TABLE

condensetocols

setfooterrowcount

combinecols

setcellstylerange

openinbrowser

exportxml

totable

CELL

setfill

setuirgb

setheader

RECORDSET
callback

settabular

DOCUMENT getlinks

FIELD setformattedcontent

• Added toString() support to EasyCatalog’s objects.

•  The field command now returns a table object if the field is tabular [1963]

•  Custom adopt LUA script now gets passed “textcontent” for text links [2002]

•  Added socket support to LUA to allow remote debugging [2068]

•  RECORDSET.tableof() now returns all data if no parameters were specified.   [2076]

•  A “Dependency” edit field has been added to the “Advanced” custom field option, where a comma separated list of custom fields 
can be specified. [2124]

•  Performance enhancement for LUA command ‘distinctrows’ when dealing with large tables [2190]

ODBC Data Provider 

•  If an SQL statement starts with a parameter {{xxx}} then the remainder is treated a LUA code and executed with the parameters 
passed in. The return of the LUA code becomes the SQL statement. e.g:-

{{limit:5}}if limit == “” then return “SELECT * FROM \”table\””; else return “SELECT * FROM \”table\” LIMIT “ .. limit; end [2130]

Pagination Module 

•  Added “Update Furniture After Pagination” check box on Paginate dialog [2044]

•  Custom field commands are now supported in fitting Minimum and Maximum height fields [2113]

•  Automatic pre-flight is now disabled before pagination commences: this has been shown to improve performance. [2142]

• Added new keyboard shortcut ‘Update Furniture on Selected Pages’ that will only update the furniture on the pages selected in 
the Pages panel. [2065]
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•  Performance enhancement - disable place count tracking during pagination [2223]

•  Added support for meta-characters in Pagination Rules Action “Value” field [2235]

•  The the last paragraph is deleted as a result of the “Remove Blank Lines for Empty Fields” operation, the carriage return at the 
end of the previous paragraph is now removed to prevent an empty paragraph being left behind at the end of a text flow. [2066]

• Added “Round up to nearest” pagination rule to Fitting > Frame Depth to Content Depth.  For example if, after fitting, the text frame 
depth is now 17mm, and the “Round up to nearest” attribute is set to ‘5mm’, the frame will be resized to 20mm (the next nearest 
multiple of 5mm). [2119]

Field and Group Names are now selectable on the Pagination Rules panel

Pagination attributes that require either a group or field name now feature a pop-up to select from. This will only appear if you have 
a selection in one of your data source panels (so that EasyCatalog knows which data source to display fields/groups from).

• Added group and field names to right click context menu on Pagination Rules panel.  [2150]

• Field pop-up now available on the New/Edit Action dialog if the user has made a panel selection before opening the dialog. [2169]

•  Group and Field Name attributes now use a pop-up rather than edit text field. User needs to make a selection in the relevant data 
source panel before double clicking on the pagination rule for the pop-up to appear. [2147]

‘Into Text Flow’ Pagination

• Add Force Break > Paragraph Break Pagination Rule.  This attribute only applies during flow-based pagination. [1551]

•  Added “Paragraph” break type to “Break on Field Change” for flow-based pagination [2030]

•  “Keep With Next” attribute now works with flow-based pagination by applying the “Keep With Next” attribute to the text/anchored 
object that’s inserted. The “Keep With Next” attribute can now be “Yes”, “No” or “Unspecified”. “Yes” will set keep-with-next to 1 
line; “No” will turn off keep-with-next and “Unspecified” will not change the keep-with-next attribute applied to the text/anchored 
object just inserted. [2108]

Formatting Rules

•  Added ‘Populate on Drag ‘n’ Drop’ checkable menu option to the Formatting Rules panel which will populate the Formatting Rule 
with data from the selected record(s) when dropped on the document. [2100]

•  Formatting Rule dialog, Filters field drop down menu are now sorted alphabetically. [2227]

‘At Page Guide Positions’ Pagination

• Performance enhancement when paginating grow-and-flow items. When we a ‘growing’ frames we no longer populate the grow-
and-flow frame(s) on the new page with content, since it will be emptied and linked into a text chain anyway. This offers a massive 
performance boost when lots of data is flowing over multiple pages. [2179]

•  Internal performance enhancements.

• Always uses command sequence as it’s quicker

• Reduced number of collision checks

• Reduced number of rectangles stored in collision list (e.g. group boxes don’t store child box rects) [2232]

‘Using Master Pages’ Pagination

•  Added support for master page items in the slug area of the page [2040]

• The page number field can contain multiple values separate by comma. For example, “1,3,5” will paginate the item on those three 
specified pages [1405]
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Relational Module 

•  Increased size of ‘Edit Level’ dialog [2116]

• Added support for custom Adoption on a Relational Panel [2025]

Scripting Module 

•  Added support for demo extension codes to ‘register’ script call, primarily to allow Server trial to be extended. [1952]

•  URL download error report not shown during script execution if user interaction level is not ‘interactWithAll’ [1957]

•  Added ‘updateFormattingRulesDuringUpdateDocument’ property to DSO, which is the equivalent of checking/unchecking the 
‘Update Formatting Rules’ option on the ‘Update Document’ menu.

var my EasyCatalog = app.easycatalogObject;
var myDS = app.easycatalogObject.datasources.item(“Stock.csv”); 
myDS.updateFormattingRulesDuringUpdateDocument=true;

  [2058]

•  Added ‘preventImageURLDownload’ property to DSO, which is the equivalent of checking/unchecking the ‘Prevent Images From 
Being Downloaded’ option on the ‘Images’ menu.

var my EasyCatalog = app.easycatalogObject;
var myDS = app.easycatalogObject.datasources.item(“Stock.csv”);
myDS.updateFormattingRulesDuringUpdateDocument=true;

 [2059]

• Added ‘deleteUnusedURLImagesOnSync’ property to DSO, which is the equivalent of checking/unchecking the ‘Delete Unused 
Images on Synchronize’ option on the ‘Images’ menu.

var my EasyCatalog = app.easycatalogObject;
var myDS = app.easycatalogObject.datasources.item(“Stock.csv”);
myDS.deleteUnusedURLImagesOnSync=true;

 [2060]

• myDS.updateTablesStructureForTabularFields=false; [2062]

•  Added an optional parameter to the UpdateFurniture script call to specify if overridden furniture should be removed [2080]

• Added ‘adoptCustom’ on the EasyCatalog Object to execute a custom adopt using LUA code [2084]

•  Added optional parameter to ‘selectedRecords’ to specify whether a new panel should be opened. Pass ‘false’ as the first 
parameter to prevent the panel being visible in the UI (this parameter has no effect in Server). Users should be careful to close the 
DSV that’s returned as there’s no way of closing it via the UI. [2093]

• ‘replaceFields’ now takes a document or page item [2128]

•  Added ‘select’ to DataView object - this is a zero-based index version of ‘makeSelection’ and accepts the same parameters.
 [2141]

•  ‘addField’ now updates the XPath of a field if it already exists. [2182]

•  Added the following properties to retrieve version number information:
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app.easycatalogObject.majorVersionNumber; // e.g. 13
app.easycatalogObject.minorVersionNumber; // e.g. 0
app.easycatalogObject.stepVersionNumber;  // e.g. 3
app.easycatalogObject.buildNumber;        // e.g. 16000
app.easycatalogObject.versionNumber;      // e.g. “13.0.3B16000”

  [2191]

•  ‘selectedRecords’ now creates a DSV which is a copy of the originals configuration. [2205]

XML Data Provider 

•  Added initial support for applying XSL to XML before it is processed by XPath parser - place a file called “Default XSLT.xsl” in the 
root of the workspace folder. [2135]

•  Change the way XML fragments are created to be more efficient and complete [2228]

EasyCatalog for InDesign Server

EasyCatalog for InDesign Server benefits from all of the non-User Interface enhancements from the desktop version. The following 
enhancments affect the Server version only:

• EasyCatalog for InDesign Server now outputs number of trial days remaining to console at startup [1954]
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Bug Fixes

The following bugs have been fixed in this release of EasyCatalog.  For clarity, the bug reports listed below show the original 
problem as reported.  It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog. Note 
that some bugs listed here refer to issues that were encountered with new features in the beta version by our beta testers and are 
included here for completeness.

EasyCatalog 

• Selecting images on a multi-page tool tip now working [1594]

• ‘Is Empty’ / ‘Is Not Empty’ not working for date fields when creating a subset [1980]

• “Unknown cell style” error when cell position index specifies a record that doesn’t exist [1981]

• Key Finder keyboard shortcut crashes in CC 2018 [1985]

• Field place count is incorrect after deleting a box containing an anchored box (which contains fields) [1992]

• A field set as ‘Hyperlink’ in field options cannot be used during “Update Panel > With Page Numbers” when “All instances” is 
selected. [2001]

• ‘Hide Empty Groups’ is not being applied when loading a configuration [2006]

• Adopt Fields is deleting ‘Computed Field’ commands on picture frames [2010]

• “Update Panel > With Page Numbers” not updating image scale/position/etc for URL-based images [2012]

• Potential protective shutdown if image in box cannot be relinked when “Preserve Size and Position on Update” [2016]

• If a hyperlink has been added to an image frame, it’s not removed during “Update Document” if the destination URL is now empty.
 [2021]

• Hardware key changing on Windows using new activation server [2031]

• Empty Cell Content does not always replace Field Specifier in matrix table if table attribute characters are present. [2032]

• Encoding type is not being set in reports HTML, which can lead to characters being incorrectly displayed in some browsers. Users 
will need to delete the “xslt.xml” file from their “ EasyCatalog Reports” folder for this change to take effect. [2033]

• Added error message when attempting to import data source from inside workspace folder. User is now prevented from doing 
this. [2036]

• Fixed bug with tabular field setup in CS6 [2039]

• BOOKMARK hyperlinks are always showing as ‘in error’, and an extra space is sometimes left behind after the closing field marker.
 [2049]

• Document content is being populated before conditional processing is processed, which results in a performance overhead. For 
example, tables are being populated in the document that may ultimately be deleted by the conditional processing code. [2050]

• [WINDOWS] “Import Data Source” may sometimes delete the workspace folder [2072]

• Changed population to lua code to AFTER population of Field Specifiers [2077]

• “Hide Empty Fields” should only check the records visible in the panel to see if the columns are empty. Currently it is checking all 
records in the data source which means that empty columns still remain after using this option. [2090]
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• Local cache for “Multiple Users Share This Workspace” is stored in an InDesign version-specific folder, so when the user updates 
to a new InDesign all of their data sources will need to re-sync. [2091]

• Matrix table population is not obeying column resizing attributes [2096]

• Field Option changes are lost after InDesign reboot when applying a configuration that contains Field Option changes. This only 
applies if the Configuration does not add or remove custom fields (in which case the new field options are persisted). [2102]

• RTF text import from Field Content not working - the raw RTF text is imported instead [2103]

• Flipping an image box shows incorrect values in X or Y Scale after Update Panel: flip an image box horizontally, rotation should be 
set to 180 and the yscale should be a negative value. Currently EasyCatalog is outputting a positive value. [2104]

• Cell style names containing commas cannot be applied using “Field Specifying Style Name” [2114]

• Remove Field Markers > From Document Selection removes all field markers when there is no selection [2123]

• [WINDOWS] Template data source cannot be created from sub folders of the “Templates” folder [2132]

• Panel Report would sometimes report duplicate records [2137]

• [WINDOWS] Umlauts in dates are being shown as odd Unicode characters (when using date-formatted fields). [2143]

• Fixed a bug with cell merging not working correctly on XSL based fields [2157]

• If the user has a single field in the panel selected, and a single cell in a document table selected, the field cannot be inserted.
 [2164]

• Fields not always correctly inserted into table cells - when multiple cells in the panel and the document table are selected, 
sometimes the panel content will be pre-pended to the text content in the cell. This only occurs when our table cell attribute 
character is present. [2165]

• processdatasource.lua is now called to build field content when field formatted content is created [2194]

• Table attribute characters are being inserted into tables unnecessarily - for example, when row or column options haven’t actually 
been set in the table. They should only be added if non-default options are applied to rows/columns. [2196]

• “Convert To Field Specifiers” losing Computed Field command on image boxes [2197]

• Update Panel > With Page Numbers not marking fields as ‘updated’ when blanking them out. This means that items that have 
been removed from the page, and therefore have an empty page number, may not be updated on the data source. [2201]

• Crash when specifying a cell position index for a record that doesn’t exist [2213]

• Fixes potential Record Viewer panel crash when user has been switched out of InDesign for a while [2217]

• [WINDOWS] “Import Data Source” creating sub-folders in Configurations, Data, etc. folder [2218]

• Crash when resizing a single-line text box if text box resize fails [2229]

• “Copy and Repeat” not populating graphic cells in tables [2234]

•  “Override default sorting prior to grouping” now only affects individual group levels. In previous versions, using (for example) “Data 
Source Order” could affect the order of groups at a different level in the hierarchy. [2204]

Tabular Fields

• <br> tags now don’t generate an automatic <br> prefix in tabular fields [1991]

• When populating a table from a tabular field, the overall width of the table is not always maintained if columns are deleted or the 
width of some columns are set to an explicit width. [2156]
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• Tabular field cells can be inserted inside of other fields in the document when double clicking. [2192]

• Tabular fields being updated even when on locked layers [2239]

• Cell style commands not working in tabular fields [2154]

User Interface

• Fixed an issue with one of the pop-ups on the “Update Page Numbers” dialog box not having a default selection when the dialog 
first appears. [1996]

• Configurations being displayed in wrong order on OSX 10.13. This bug would also affect other menus where files should be 
displayed in alphanumeric order. [2011]

• ‘Delete’ button is now greyed out for multi-user workspace data sources, rather than hidden. [2023]

• Buttons still remain visible when selecting ‘Custom’ location type - e.g. if the user selects “URL” as the location type and then 
changes to “Custom”, the “Options” button and “Store images in a single folder” check box remain visible. [2071]

• “Show Place Count” and “Show Multiple Placements” should appear in the right click menu when no document is open [2079]

• Missing vertical stroke of field list table of the group dialog [2101]

• ‘Alignment’ option on Field Options > Picture Content should be grayed out if both X and Y offset fields are specified [2111]

• Image previews would draw over the header sometimes with configurations visible [2184]

• Shift-clicking on a selected row does not deselect it [2203]

• Record Viewer failing to display multi-image previews correctly. [2225]

• Fixed issue with the Record Viewer Panel not showing the correct Relational selection [2138]

• Some custom field ‘examples’ not displayed in full on the custom field panel [1986]

Custom Field Commands 

• GROUPGETNTHPOPULATEDFIELDNAME sometimes matching fields not in the parameter list. This has been modified to be 
more strict when determining which fields to look at. When specifying a field name it needs to match exactly; when using a regular 
expression the expression needs to be written such that it matches the entire field name when evaluated. [2209]

• FOLDERDEEPSEARCH hanging on Windows [2075]

• XREFFIELD will not always find the record - certain strings will not be found by XREFFIELD due to an internal case sensitivity 
problem [2176]

• Custom fields are being updated twice. This should only affect previous beta builds. [2177]

• XREFFIELD on an external data source rebuilds index too often, resulting in a performance overhead. [2178]

• XREFFIELD can crash when the field you’re searching in isn’t found [2206]

• XREFFIELD doesn’t always find value being searched for when using internal quick sort [2207]

• Custom field content sometimes overwrites new field content after ‘Synchronize with Data Source’:

• Create a new data source
• Add a new custom field



©2003 - 2018 65bit Software Ltd. All rights reserved. Visit us at www.65bit.com

RELEASE NO
TES

17

• Add a new field to the data source
• “Synchronize with Data Source”

The custom field content will be placed into the data source’s new field. [2140]

Excel Data Provider

• Excel Data Provider is not reporting an error when there are multiple columns with the same name in the same sheet when “All 
Sheets” are being imported [2187]

Google Sheets

• No error reported when the same field name appears more than once on the same sheet [2210]

LUA Commands 

• ‘fitContent’ not always fitting image content when frame is grouped with a text box [1958]

• table:removeemptyrows() would always delete header rows [1995]

Pagination Module 

• Furniture items are not ignored during “Update Panel With Page Positions”. This can result in the position of page headers being 
used to update the record rather than the true position of the record. [2043]

• Furniture items are not ignored during “Update Panel With Page Numbers” [2078]

• Resizing an image box with an anchor point of center left/center right will not resize the height of the box. [1960]

• When Frame is Empty > Delete is deleting boxes with anchored frames [1970]

• Pagination rules not being re-applied to text boxes when shift or shift + alt held down when selecting “Update Document” [1988]

• Function Rule “Function” is not being persisted through IDML [2003]

• Update Furniture sometimes using field from previous page when using linked text boxes [2064]

• Pagination will start even when there are no library items/Rules to paginate with (i.e. an empty library has been selected or an 
empty Rule Set). [2112]

• Formatting Rules that are anchored in other boxes aren’t updated [2151]

• “Paginate” keyboard shortcut does not work if no document open [2153]

• Matrix table sorting and grouping now obey field options - e.g. if a field’s type is set to ‘Numeric’ then a numeric sort will be used 
rather than character-by-character. It will also obey language settings, so a field set to “German” will sort according to German 
linguistic rules rather than standard Unicode sorting. [2163]

Formatting Rules

• If a rule in a rule set is selected, delete will only remove the rule and not delete it completely. [2000]
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• If the user has filters the panel using the Quick Search text box and then populates a Rule Set with all records shown in the panel, 
Update Document will then re-populate the Rule Set with all records in the data source. [2089]

• Boxes can sometimes disappear when using the “Update Document” function on Formatting Rules that have a position index 
specified. [2095]

• Empty error dialog sometimes appears when populating Rule Sets, and Rule Set is not imported. [2186]

• Text box fitting in anchored box can sometimes fail if anchored box is anchored above the containing text frame [2230]

• Update Document > Selection not always working when table cells are selected. This will be the case when the selection is inside 
of a Formatting Rule and “Update Formatting Rules” is turned off on the “Update Document” menu. [2099]

• Some boxes are not updated during “Update Document” when “Update Formatting Rules” is not checked. [2171]

• “Update All ‘xxx’ field in the panel” should not be updating Formatting Rules [2180]

• Fixed issue when updating a rule which deletes frames, leaving only one. [2240]

‘At Page Guide Positions’ Pagination

• PostPaginateDocument.jsx is being called twice after Guide Based Pagination [2181]

• Attempting to apply empty master page when odd or even page breaks are used [2020]

• Collision Detection can sometimes place items too close together, i.e. not obeying the gutter. [2069]

• Grow and Flow boxes are always set to minimum size when continuing a flow [2118]

• [Knowbox] Collision detection gets stuck when anchored item sits above main item [2148]

• Guide-based pagination keeps inserting pages indefinitely if there is a collision - e.g. a master text frame - that prevents a library 
item from being placed anywhere. [2167]

• Guide-based pagination not always picking grow-and-flow continuation type - it’s choosing based on a left/right page placement 
first, rather than preferring a ‘grow and flow’ continuation type. [2168]

• Guide-based pagination sometimes getting stuck when using anchored objects that sit above (Down/Across pagination) or to the 
left (Across/Down pagination). [2173]

• Grow and Flow not inserting content if ‘keep with next’ operation interrupts the Grow and Flow. This bug was did not affect the 
official release version. [2185]

• Double page items sometimes sometimes appear on a right-hand page [2189]

• Fixes rounding error when determining if item fits on page. e.g. margins set at 0.5” sometimes produce rounding errors which 
means an ‘item doesn’t fit within the margins’ error is displayed. [2224]

• Incorrect gutter being applied during collision detection [2231]

• If a Product Style contains a group box (or is grouped), the group box(es) will not be stored in the collision map and may therefore 
collide with something on the page. Turn off the “Include in Collision Detection” Pagination Rule to override this. [2233]

‘Using Master Pages’ Pagination

• Crashes when paginating large documents and page number is not specified [1998]

• Specifying multiple masters would not always populate all pages with data - e.g. when paginating ‘Pages’, if there were two 
master pages specified in the “Apply Master Named In” field both pages would be inserted with the correct master applied but the 
second page wouldn’t be populated with data. [2149]
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• ‘Break on Field Change’ not using formatted field content, so options such as ‘Strip White Space’ are not having an effect. [2208]

‘Template Document’ Pagination

Template based pagination is populating boxes on locked layers [2174]

• Unable to create a book when using a data source that’s inside of a sub-folder in the workspace folder. [2193]

Relational Module 

• Fixed bug in COLLATION creation [1779]

• Dragging an image preview to the document from a Relational Panel crashes [2028]

• Not all fields are available to select in field choice popups, such as the “Break on Field Change” option in Pagination. Specifically, 
fields that are created by queries and do not come from a child data source. [2115]

Scripting Module 

• Page number not working with paginateUsingDefaults for master pages pagination, guide pagination [1984]

• Added a new function to relink part of a tabular field. Example:

myDS.relinkTabularField(app.activeDocument, “website_productText_multilingual”, “”,”de”, “”, “en”);

 [2022]

DV.paginateUsingDefaults still expects a File() parameter, even when pagination won’t use a library (if it’s using Rule Sets to 
paginate for example). This parameter can now be specified as ‘undefined’: e.g.

myDV.paginateUsingDefaults(undefined, app.activeDocument);
 [2042]

• dso.updateDocument not obeying the “Update Formatting Rules” option that’s set on the “Update Document” menu. There’s 
an optional second parameter on ‘updateDocument’ that specifies whether formatting rules should be updated or not; if this 
parameter is missing the default option should be used. [2081]

• ‘isSelected’ property not working for regular record rows - it’s always returning false, whether the row is selected or not. [2092]

• ECO.exportPageItem would sometime export images of the wrong size [1778]

XML Data Provider Module 

• JSON to XML conversion not working when top level object is an array [1962]

• If a datasource that contains parameters is opened, but the parameters are missing (perhaps the main data source has been 
edited to include new parameters that the user hasn’t configured locally) the data source won’t open. [1974]
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About 65bit Software

65bit Software Limited was founded in 2003 and specializes in the development of high quality Plug-ins for Adobe 
InDesign and InCopy. 
We believe that the growing processing power of today’s desktop computers is allowing the development of a new 
breed of tools, offering levels of integration, power and ease of use previously only seen in high end publishing sys-
tems. 
At 65bit we are committed to providing best of breed solutions for the database publishing, catalog, newspaper and 
magazine markets. 
In addition to developing InDesign Plug-ins, we offer custom development services and can help you to design and 
implement an InDesign or InCopy-based solution. You can learn more about our services or submit a request for 
more information by sending an email to sales@65bit.com 
DAM/System Vendors - Any of our products can be included and branded as part of your solution. Please contact 
sales@65bit.com for more information. 

Contact Details

Postal: Meriden House 
6 Great Cornbow 
Halesowen 
West Midlands 
B63 3AB

Web: http://www.65bit.com
Sales: sales@65bit.com
Support: support@65bit.com 

http://www.65bit.com/support
Feedback: We welcome all feedback and bug reports on 65bit products. Please email any comments to: 

support@65bit.com 
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